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1 Purpose
The purpose of this document is to guide the system installer with the steps necessary to install
and configure the Universal Devices’ ISY system and operate the GUI (Graphical User Interface).
ISY comes configured for communications with the device(s) of your choice. The package
contains:
•

Power supply

•

Ethernet cable (Blue Cable)

•

A Serial/RS232 cable

•

Documentation and Utilities disk

•

Quick Setup Guide

•

Smarthome INSTEON PLM (Power-line Modem)

2 Installation and Configuration
This section will cover the basic ISY installation enumerating the pre-requisites of the host
computer and the network requirements. It will also cover the host computer configuration and
provide you some instructions on the host computer start up.

2.1 Installation
Please perform the following steps before plugging the ISY into power:
•

Connect the Ethernet cable to ISY and to your network hub. Note: the network must be
DHCP enabled. If your DHCP is not enabled, please consult ISY Installation and
Configuration Guide on the accompanying CD

•

Connect the Serial communications cable provided with your INSTEON PLM (included in
the package) to the connector marked Port A on the ISY

•

Plug in the PLM into a power outlet

•

Plug in the power supply into ISY and then into a power outlet

2.2 Prerequisites
2.2.1 Host Computer Software
•

Windows XP/Vista, MAC/OS, Linux

•

Internet Explorer 7 and above

•

Java 1.6 (JRE 1.6) – included in the setup disk

•

Microsoft Excel, for trending and charts

2.2.2 Network
•

DHCP enabled network

•

Ethernet topology

2.3 Host Computer Configuration
•

Configuration is comprised of three very easy steps:

•

UPnP Configuration (For Windows XP and Vista)

•

Java Installation

2.3.1 Configuring Windows XP
•

UPnP is normally disabled on all computers by default. In order to make sure and/or to
configure UPnP, please follow the following steps (refer to Figure 1):

•

Click on My Network Places (either on the Start Menu or Desktop)

•

On the left Navigation Pane

•

If you see “Hide icons for networked UPnP devices”, you are done. No further action is
necessary

•

If you see “Show icons for networked UPnP devices”, click on it and let the system get
configured. You are done.

Figure 1. UPnP Configuration

2.3.2 Java Installation
If you already have JRE 1.6 installed, then no further action is necessary. Otherwise, click on the
jre-xxx.exe (where xxx are major/minor versions) on the installation CD to install JRE.

2.4 Starting the GUI on a Host Computer
2.4.1 Windows XP
If you already have Java installed and UPnP enabled, all you have to do is to click on the icon My
Lighting (refer to Figure 1) appearing in the My Network Places (refer to Figure 2) either on the
Start Menu or Desktop.
If the “My Lighting” icon did not show up on your My Network Places you will need to follow the
configuration steps below.
Configuration is comprised of three very easy steps:
i.
UPnP Configuration
ii.
Java Installation
iii.
If you have any other network firewall software, please contact us to walk you through the
configuration.

Figure 2. Network neighborhood/My Network Places
In your Network Neighborhood/My Network Places double click on the My Lighting icon, see
Figure 1 – UPnP Configuration. See section 2.4.5 for the Initial Browser Window

2.4.2 Initial Browser Window

Figure 3. Initial Browser

Please do not close this browser window. You can minimize it but you can not close it at any time
while the GUI is running or the application will terminate. Following the above browser that
opened the ISY GUI will appear and you will be presented with a user-id/password dialog box,
See Figure 4. Please enter admin for both the user-id as well as the password.

Figure 4. ID & Password

3 GUI
3.1 Components
The ISY GUI is very intuitive. It is comprised of complementary panes (refer to Figure 5) that
allows the user to navigate, view, operate and configure the lighting network.
The main GUI components are the Top and Lower Pane.

TOP PANE

LOW ER PANE

Figure 5. Main GUI Components

The Top Pane is located at the top section of the GUI. It always contains the menu, tool bar, the
location current date and time, and location sunrise and sunset time. This section always
remains the same no matter which action you are performing.
The Lower Pane has four tabs to choose from: Main, Program Summary, Program Details and
Configuration. Each tab selected will show the network details for the user to monitor, control, or
configure the lighting network.

3.2 Navigation
Navigating through the various menus, submenus, tree/node and toolbars uses the Windows
point and click features.
You can drag and drop components from one node to another when permissible or applicable.
The Left mouse click normally selects the item where the mouse pointer is, otherwise the click.
Keeping the left mouse button pressed after selecting and moving the mouse will drag the item.

Selecting an item with Right mouse button will show you a menu for that item. Release the right
mouse button and select the menu with the left mouse button.

4 Menu
This section details the functionalities and the operations of each menu option listed in the Top
Pane.

4.1 File Menu
Please see Figure 6 for all File Menu options.

Figure 6. File Menu

4.1.1 Logon
The Logon option will be enabled if you are not connected to the ISY. The system will prompt you
that you have lost the connection and you must login. Once you select this option you will be
required to enter your user name and password.

4.1.2 Set Userid/Password
Once this menu option is selected the user can change the user name or password or both. The
new user name or password, or both should be typed in the appropriate field.
Please make sure you remember the new user name or password as the old default account of
user name and password admin will no longer work in future logins.

4.1.2.1 Resetting Userid/Password
Before you proceed with the procedure below, you will need to retrieve the MAC address of the
device. Refer to 4.4.1 for locating the MAC address.
To reset your userid and password please follow the steps as outlined below:
•

Disconnect PLM from the ISY.

•

Telnet to ISY

•

Enter MAC address as both the userid and password at login prompt

•

Wait 45 seconds (or until you see "Please connect PLM message")

•

Plug PLM back in

•

Log in again using admin/admin

Note: There is a timeout of 5 minutes for the PLM to get plugged back in. If timed out, the userid
and password are not reset.

4.1.3 Backup ISY
Selecting this menu saves the entire ISY configuration in a file. The user will be prompted to
select or type the storage location and name the configuration file. Note the location and file
name for future use.
The following system information will be saved to this file:
i.
Time Zone, Latitude, and Longitude
ii.
Notification recipients
iii.
Programs
iv.
INSTEON devices information and scene memberships
v.
INSTEON devices links
vi.
Scenes information

4.1.4 Restore ISY
Selecting this menu option allows the user to locate and select the ISY’s backup configuration file
(see 4.1.3). Upon completion, this operation reboots ISY and closes your browser.
This option only restores the settings and has no impact on the underlying INSTEON devices and
their configurations. If you wish to restore INSTEON device configurations, links, and settings
please follow up this operation with Restore Devices menu option (see 4.1.5) upon ISY reboot.

4.1.5 Restore Devices
Selecting this menu option starts the ISY to use the current configurations settings stored within
ISY, and reprograms all the INSTEON devices based on them. Upon completion, this operation
reboots ISY and closes your browser.
This operation is most useful if INSTEON devices and their logical representations on ISY are out
of synch. This scenario might happen if INSTEON devices are manually linked without using
ISY’s GUI.

4.1.6 Restore Modem (PLM)
This operation is most useful when you need to replace a defective PLM and the ISY is rebooted
with a new PLM.
When the communication links were established via the Link Management Menu, the PLM and
INSTEON devices adds each device addresses it is linked to, in its own link table.
The ISY also reads and stores the PLM’s address at boot up. The ISY stores all the
configurations settings of the lighting network. If you are replacing a PLM the ISY will have the
old PLM address link stored in it.

Warning: Never replace your PLM while the ISY is running because it will assume it is still
connected with the old PLM. The ISY will appear to work, but it will be writing the address of the
old PLM into the device links, thus you will not see devices updates etc.
If this menu option is selected, the ISY goes through all INSTEON devices looking for old and
new PLM address links. If an old PLM address link is found, it replaces it with the address of the
new PLM and adds the corresponding device link to the new PLM.
To replace a PLM:
i.
Unplug ISY from the power outlet
ii.
Unplug the PLM from ISY and power outlet
iii.
Connect ISY’s port A to the new PLM
iv.
Plug the new PLM into a power outlet
v.
Plug ISY into a power outlet
vi.
Open the browser to ISY’s GUI and wait for system initialization to complete
vii.
Click on the Restore Modem (PLM) menu option

4.1.7 Remove Modem (PLM)
Before selecting this function, create a backup ISY file.
The modem (PLM) is the communication bridge between the ISY and the INSTEON devices.
Without the modem and the links you cannot control or get status from the INSTEON devices.
When the communication links were established via the Link Management Menu, the PLM and
INSTEON devices adds each device addresses it is linked to, in its own link table. The ISY also
stores the PLM’s address.
If you need to remove a modem from your lighting network, select this function. It will disconnect
the ISY from the PLM and the PLM from all INSTEON devices in the network, removing all the
links between them. This ensures orphaned links do not exist in the INSTEON devices when the
PLM is removed from the lighting network. Also, it ensures the ISY is not looking for the removed
PLM.
Orphaned links are links between two devices where one is no longer in the network. Orphaned
links will affect the lighting network performance. A device with an orphaned link to a missing
PLM will create unnecessary network traffic by trying to communicate with the PLM multiple
times. This in effect will slow down the network response.
All ISY programs, Triggers or Schedules, will not work when you remove the modem from the
lighting network. Also, the actual status of all INSTEON devices will not be synchronized with the
status reported on the screen.

4.1.8 Enable/Disable Internet Access
In order to achieve remote/internet access, you will need to setup your router for port forwarding.
Port forwarding allows the ISY’s port to be seen over the internet.
The controller default setting is with internet access disabled. If you would like to enable internet
access to the controller select this option. It is reversible and you will be presented with the
Disable Internet Access menu option.

For a list of supported routers, please checkout [the URL in the wiki where we have a list of
supported routers; you can find this list embedded in http://forum.universaldevices.com/viewtopic.php?t=8 ]
If you do not have one of the routers listed above, please contact us and we’ll walk you through
setting up your router (port forwarding) manually.

4.1.9 Exit
Once this menu option is selected this application will end and the browser window will close.

4.2 Link Management Menu
Just as you manually link a pair or multiple INSTEON devices to allow them to communicate with
each other, the ISY needs to be linked with all the INSTEON devices it needs to manage or
communicate. This menu allows you to link the ISY to all or selected INSTEON devices.
Please see Figure 7 for all Link Management menu options.

Figure 7. Link Management Menu

4.2.1 Start Linking
The basic method of linking an INSTEON device is to set a device as a controller in linking mode
then going to the responder and set it to linking mode. The same method is true in linking the ISY
to the devices. You set the ISY (the controller) to linking mode then go each responder and set
those to linking mode.
Select this menu to start linking all devices, except the ControLinc and RemoteLinc, to the ISY.
The linking process allows the ISY to build a database of devices in the network and the
relationships between each or multiple devices, and to program these devices.
When you set the ISY in linking mode, this sets it to multilink mode. In multilink mode, the
controller is able to read or link with one device set in link mode, one after another. So as long as
Link in Progress dialog is open, the ISY will be in multilink mode.
If you do not see Link In Progress dialog, then check trouble shooting section: If RX light is solid
on, PLM or cable to the PLM is bad
The Linking in Progress dialog has three options in the linking process;
•

Overwrite existing links (default)

•

Add devices found in links (Removes existing links)

•

Add devices found in links and keep existing links.

You can use either of these options in adding a new device.

Figure 8. Linking In Progress Dialog

To link
i.
ii.
iii.
iv.

devices:
Choose this menu option
Select the link option.
When “Linking In Progress” (see Figure 8) dialog appears, press the “Set” button on each
new INSTEON device (light, switch etc.) for as many devices as you desire.
When you are done linking all the desired INSTEON devices, click on the “Cancel” button
on the “Linking in Progress” dialog.

4.2.1.1 Overwrite Existing Links
This option programs the devices with the linking information that is stored in the ISY’s
configuration. The linking information used is from the scenes or groups created in ISY. It will
remove, clear, and overwrite any previous manual linking, grouping or setting.
Depending on the number of devices linked and the type of devices, ISY’s reprogramming of the
devices may take roughly 10 seconds to 1 minute per device. Please be patient while ISY
reprograms the devices and do not perform any operations on your INSTEON devices.
This operation performs the same action as the Start Linking button on the tool bar (

). When a

). The new device(s) should
linking session is in progress, the icon for this button changes to (
automatically show up on the ISY GUI when they are linked as described in 4.2.1.

4.2.1.2 Add Devices Found in Links and Remove Existing Links
Check this option when you’d like to find all the devices linked to a particular device being linked
to ISY. This operation searches (crawls) the network to find all other INSTEON devices of which
a path can be found. This operation is mostly useful for devices which are out of reach or if one
does not wish to keep linking each device individually.
This option does not regenerate the links between devices nor does it regenerate the scene or
group memberships. It simply finds, register, or link devices found with ISY to make
administration easier.
If a device was previously linked with the ISY and later was manually set with a new scene or
linked to other new device address, the ISY will not contain these manual settings. Re-linking the
device with this option activates the ISY to compare the device database with its database
searching for a new device address. If a new device address is found, the ISY will save the new
address into its database. It will then remove, overwrite or clear the device with the configuration
found within ISY. This means that whatever was manually entered is now lost.

4.2.1.3 Add Devices Found in Links and Keep Existing Links
This option is the same as “Add Devices Found in Links” except it does not overwrite the device
settings, manual or otherwise. It will bring all the links found in each discovered device, try to
make scenes out of the relationships, and maintain a copy of all the settings the device already
contains.

4.2.2 Link a ControLinc
Choose this menu to link a ControlLinc. When the “Link a ControLinc” dialog appears, press and
hold the “Channel 1” button for 10 seconds or until the ControLinc’s light starts flashing. Then
click on the “Ok” button (see Figure 9).
Note: You cannot discover or find other devices linked to the ControLinc using this option.

Figure 9. Link a ControLinc Dialog

4.2.3 RemoteLinc
Choose this menu to link a RemoteLinc. When the “Link a RemoteLinc” dialog appears, press
and hold the “Button 1” button for 10 seconds or till the RemoteLinc’s light starts flashing. Then
click on the “Ok” button (see Figure 10).
Note: You cannot discover or find other devices linked to the ControLinc using this option.

Figure 10. Link a RemoteLinc dialog.

4.2.4 New INSTEON Device
Choose this menu if you already know the INSTEON address of a device and if you do not wish
to use the regular linking method of pressing the “Set” button.
After selecting this menu option, the “New Insteon Device” dialog appears as shown in Figure 11:
i.
Enter the INSTEON address of the device using the following format where A, B, and C
are the address parts as depicted on the INSTEON device itself

a. A B C or
b. A.B.C

ii.
iii.

iv.

If you wish to automatically add all the other devices linked to this device, click on “Add
Devices Found in Links” (see Figure 11).
Note: This option does not generate the links between devices nor does it regenerate the
scene/group memberships. It simply finds, registers or links devices found with ISY to
make administration easier.
Click on “Ok"

This operation performs the same action as the New INSTEON Device button on the tool bar (
).

Figure 11 Linking In Progress Dialog

4.2.5 New Scene
Creating Scenes in ISY allows the user to set ramp rates, set on level, link or group devices
without physically going to each device(s) to manually set, link or group them. Let’s say you want
to link a device in a bedroom to a device in the kitchen. When manually linking these devices,
you will have to physically go to the bedroom device set it to linking mode then go to the kitchen
device set it to linking mode. This process can be done via the ISY by creating a scene, naming
it, then placing the bedroom and kitchen devices into the scene. The system will automatically
link and program the devices.
Once you select this menu you will be presented with the “New Scene” dialog (see Figure 12)
requesting a name for the new Scene. Enter the name you prefer (the name can be changed at a
later time) and click on “Ok”. The new scene will be added to the tree view on the left pane.
This operation performs the same action as the New Scene button on the tool bar (

).

Figure 12. New Scene Dialog

You can drag and drop any one of the devices already linked to the system into any scene. If you
click and drag correctly you will see a plus sign next to the device you are dragging. Dragging
devices to scenes will not remove it from the master list of devices (ISY Node) or from other
scene(s) they already belong to. As such, each device may belong to many scenes.
You can select multiple devices by holding down CNTRL key and selecting the devices with the
mouse pointer. Drag the selected devices and drop them into the scene folder. A prompt screen
to set which device is the controller or responder will be presented. Select the device then click
on the “Controller/Responder” button to set the device. This button toggles between responder
and controller.

Figure 13. Confirm Add dialog or prompt.

A device assigned as the controller of the scene is the device that initiates the scene. This device
will control the responders according to the level and ramp rate settings.
It may take roughly 10 seconds to a few minutes to reprogram the device(s) to become part of a
scene depending on the complexity and the number of other devices, and especially
controllers/masters, for that scene.

Figure 14– New Scene Dialog

This operation performs the same action as the New Scene button on the tool bar (

).

Refer to 0 for more information about Scenes.

4.3 Tools Menu
Please note that the Tools Menu will not appear immediately unlike the other menus, it will take a
few seconds before it appears. This is due to the amount of time it takes to download the chart
and floor-plan applications from ISY. See Figure 15 for all Tools Menu options.

Figure 15. Tools Menu

4.3.1 Trend (Chart)
Once you select this menu you must wait a few seconds. You will be presented with the chart
window (see Figure 16) which offers multiple trending and charting options for each device, for a
group of devices or for all the devices linked to ISY. This operation performs the same action as
the Trend (Chart) button on the tool bar (

).

Figure 16. Chart Window and Menu

4.3.1.1 Trend - Categories Menu
Categories menu allows you to choose which attribute is charted. Currently, the following
categories are supported:
i.
Status – the status of the device charted in time
ii.
On Level - the On Level of the device charted in time
iii.
Ramp Rate – the Ramp Rate of the device charted in time

4.3.1.2 Trend – By Group Menu
This menu will display each device and each group available in ISY. You would first have to
choose a Category (see 4.3.1.1) before choosing a group or device in the menu. You can go back
to the Categories Menu and choose each available option for the device or group selected in the
Group Menu and the chart displayed will contain only the information specific to that device or
group of devices.

4.3.1.3 Trend - Log Menu
Selecting this menu brings up a Windows Excel window. You will be requested to allow macros to
run. You must select OK for the macro to run and to have access to the log file. The log file
contains the date and category intersections for all the devices linked to ISY.
If your log file is empty you probably don’t have macros enabled. To enable macros:
i.
Click on the Tools menu
ii.
Select Macros
iii.
Select Security and choose Medium for level

4.3.2 Log (Excel)
This menu is the same as the Trend – Log menu option (see 4.3.1.3)

4.3.3 Reset History
This menu allows you to reset the information captured in the log file. The information already
captured will be deleted and the log will restart from this point of time. Once you select this option

you will be presented with a confirmation dialog. You may select OK to proceed and delete the
logs or Cancel to exit without deleting the logs.

4.3.4 Generate Topology
This menu allows the user to document the network topology. It generates an HTML file that
contains the list of all the device name, address, type, properties, links and scenes. This list is
useful for troubleshooting the network or simply as a reference.

4.3.5 Floor Plan
This menu provides a graphical representation of the location of each device. It allows you to
create locations (rooms) and place devices in their physical location. This will help if at a later
time you would like to know where the specific device you are controlling is located. Once you
select this option you will be presented with the floor plan window (see Figure 17).
There are two options for creating a physical location:
i.
ii.

By clicking on the “New Location” icon at the top (
).
By dragging and dropping an existing scene from the Navigation Pane

After creating a physical location, you can drag and drop devices from the Navigation Pane
directly into any location on the Floor Plan’s Window. Devices which are dropped into the Floor
Plan maintain their relationships and, as such, clicking on any of the controlling (master) devices
on the Floor Plan highlights the associated responders with the Floor Plan. Also, each device
has its state captured as part of its name (i.e. Hall1[off]). This operation performs the same action
as the Floor Plan button on the tool bar (

).

Figure 17. Floor Plan Window

4.4 Help Menu
See Figure 18 for all Help Menu options.

Figure 18. Help Menu

4.4.1 About
The About menu option will show the ISY’s MAC Address and firmware version, the URL that
contains the IP number and port, and whether or not the internet access is enable or disabled. If
the internet access is enabled, the IP address for remote access will be shown.

Figure 19. About dialog.

4.4.2 User Guide
The User Guide menu option will download and open this file using Adobe Acrobat reader.

4.4.3 Manually Upgrade ISY
This option enables you to upgrade/downgrade ISY firmware using a predefined or downloaded
file.

4.4.4 Automatically Upgrading ISY
The preferred method of upgrading is to utilize the Auto Upgrade feature which notifies you
whenever there’s a new upgrade available. Refer to Figure 20. Auto Upgrade Notification screen.
The notification will list the enhancements and allow you to update the system by selecting the
‘Yes’ button.
If you choose not to update and later choose to update you can simply choose Help>Automatically Upgrade [My Lighting] to [Version] menu option. This menu selection will only
show up after the notification message is received. Refer to Figure 21.
Note: You must already have an AutoUpdate userid and password in order to utilize the
AutoUpgrade feature

Figure 20. Auto Upgrade Notification screen.

Figure 21. Auto Upgrade via the pull down menu.

5 Tool Bar
This section details the functionalities and the operations of each Tool Bar icon available in the
Top Pane.

5.1 Expand All
The Expand All is the first button on the tool bar. Its symbol is a plus sign. Please refer to Figure
22. Once you click on this button all the groups on the Tree View will expand and all the devices
within them will be listed.

Figure 22. Expand All

5.2 Collapse All
The Collapse All is the second button on the tool bar. Its symbol is a minus sign. Please refer to
Figure 23. Once you click on this button all the devices in each of the groups on the Tree View
will collapse and minimize and you will only see the group names.

Figure 23. Collapse All

5.3 Sort
The Sort button is the third button on the tool bar, see Figure 24. Pressing it will alphabetically
sort all the groups and devices listed in the Tree View.

Figure 24. Sort

5.4 New Scene
The New Scene button is the fourth button on the tool bar, see Figure 25. It performs the same
function as Link Management->New Scene menu option (see section 5.2.5).

Figure 25. New Scene

5.5 New INSTEON Device
The New INSTEON Device button is the fifth button on the tool bar, see Figure 26. It performs the
same function as Link Management->New INSTEON Device menu option (see 4.2.4).

Figure 26. New INSTEON Device

5.6 Start Linking
The Start Linking button is the sixth button on the tool bar, see Figure 27. It performs the same
function as Link Management->Start Linking menu option (see 4.2.1).

Figure 27. Start Linking

5.7 Floor Plan
The Floor button is the seventh button on the tool bar, see Figure 28. It performs the same
function as the Tools->Floor Plan menu option (see 4.3.4).

Figure 28. Floor Plan

5.8 Trend (Chart)
The Trend (Chart) button is the eight and last button on the tool bar, see Figure 29. It performs
the same function as the Tools->Trend (Chart) menu option (see 4.3.1)

Figure 29. Trend (Chart)

6 Main Tab
This tab provides the user the ability to view the top level status of the network or the device
details by selecting a tree node (tree branch).

6.1 Main Tab Layout
The GUI is divided in three panes; Tree View (Navigation) Pane, View Pane, and Operation
Pane. Refer to Figure 30.

TREE VIEW

VIEW PANE

OPERATION PANE

Figure 30. Main Tab screen layout.

6.1.1 Tree View (Navigation Pane)
The Tree View is located on the left section of the GUI. At the top of the tree is the node that
shows the whole Network.
The tree may expand, grow, or shrink based upon the number of devices that have been linked to
ISY as well as user actions. There are only four distinct types of nodes that you may find on the
tree view (refer to left pane in Figure 30):
Network or Root Node
physical attachment to any ISY.

- shows all the devices in the network regardless of their

ISY Node
attached/linked to ISY.

- shows all the devices physically (though could be wireless)

- identifies a Scene which is a grouping of INSTEON devices with
Scene Node
certain attributes (such as on level and ramp rate).
INSTEON Device Node
- identifies an INSTEON device. Note: the icon changes
based on the type of INSTEON device.
Clicking on the icons on the tree view brings up the associated view in the view pane.
Right clicking on the icons on the tree view brings up a menu of actions appropriate only for that
node on the tree.

6.1.2 View Pane
The View Pane is located in the right sections of the GUI. The view pane changes based on the
tree node selected.
Selecting Network, ISY, and Scene nodes presents an overview and tabulation of all the
INSTEON devices with pertinent and important information relating to each device (such as its
current state). It is specifically designed to give you an immediate access to most needed
information during setup, while simple navigation features enable the user to jump to a device
(such as a switch) to perform necessary actions.

6.1.3 Operation Pane
The Operation Pane is located at the bottom section of the GUI. Depending on the option or node
selected on the Tree View it will contain the actions you can perform.
If you selected an INSTEON device or a Scene in the View Pane or the Tree View; the Bottom
Pane will show the actions you can perform on the device or the Scene respectively.

6.2 Network Node
The network node shows a table of all devices and its status in the network. If you only have one
ISY unit, the table presented in this level is the same as the table in the ISY node.

6.3 ISY Node
This node is named My Lighting by default. Its Icon is a computer to the left of the node name.
Selecting the name on this node presents a table in the view pane. The table contains the status
of all the devices linked to the ISY.

Figure 31. ISY Node (My Lighting) Table of devices and their status.

Placing the mouse pointer over the node name and pressing the right mouse button will show the
menu shown in Figure 32.

Figure 32 – ISY Node/Icon/Menu

Expanding the ISY node by selecting the (+) sign on the tree or toolbar will show all the INSTEON
devices (INSTEON Device Node, refer to 6.3.4) that are linked to the ISY. You cannot delete this
group.

6.3.1 Query
When you select the Query option on the menu, the ISY will start to query the network to retrieve
the status of each device linked to it. Any new status retrieved is presented in the table. This
operation can take 5 to 10 seconds per device.

6.3.2 Rename
The Rename menu option allows you to rename the ISY node.

6.3.3 Start Linking
This menu option performs the same function as Link Management->Start Linking. Refer to 4.2.1
for more information.

6.3.4 INSTEON Device Node
This device node is located as a branch under the ISY node. Expanding the ISY node (My
Lighting), will show the devices within the network.

Figure 33. ISY Node branch expanded showing devices.

Selecting a device in the INSTEON Device branch will show the device properties in the view
pane.
The pane will also have controls by means of a slider or buttons. These controls allow the user to
directly control and setup the device via the computer. Currently the ISY supports all SmartHome
lights, switches and dimmers. Depending on the device that is linked to the system, you will be
presented with the permissible control action the system can help you perform and automate.
For example in Figure 34 the KeypadLinc named as “Entry-1 Overhead” light was selected and its
properties are shown in the view pane.
On level and ramp rate adjustment are controlled with a slider control. On level sets the amount
of light within 0 and 100%, where 100% is full brightness or ON. Ramp rate sets the amount of
time it takes to reach the set ON level from OFF to ON and from ON to OFF.
Setting the device properties via the ISY does not require you to press the set button on the
device. Unlike manually setting the ramp rates and ON levels, you need not press the Set Button
to store the set values. All you need to do is set the sliders to the desired level or ramp rates.

Figure 34 – Device Properties

Buttons available are ON, Fast ON, OFF, Fast OFF, Brighten and Dim.
ON or OFF Buttons, turns on/off the lights using the preset ON/OFF levels and ramp rate. This
action is similar to pressing the switch once.
Fast ON/OFF Buttons, turns on/off the lights to full ON/OFF at the fastest ramp rate. This action
is the similar to quickly tapping the switch twice.
Brighten and Dim Buttons, adjusts the light level by 5% for every click of the button. If you press
and hold the button the level will change at 5% step for every second it is held.
Mutually Exclusive Button allows you to group the buttons in Exclusive OR state. This button
select is only available with the KeypadLinc Devices. The idea is you group a set of buttons so
that only one button will be in ON state at any time. For example, you group buttons A and B,
where A is assigned as All ON and B as All OFF. The state of the status LED in each button will
be as follows:

Action

Reaction

When All ON (button A) is pressed the status LED is Lit.

Button B LED is not Lit

When ALL OFF (button B) is pressed the status LED is Lit

Button A LED is not Lit

Refer to the KeypadLinc User’s Manual Grouping Button section for more information.

The ISY creates groups by creating a scene. This is accomplished by selecting Mutually
Exclusive Button on the GUI and dragging the device buttons into the Mutually Exclusive Button 1
or 2. Refer to Figure 35.

Figure 35. Mutually Exclusive Buttons.

Button Toggle Mode sets the button state to toggle from ON to OFF and vice versa, or stay
always ON, or always OFF. Assigning a button for toggle OFF sets it to either always ON or
always OFF mode setting. The ISY will ask you to physically set the button to ON or OFF (key
status LED ON or OFF) in the process. Refer to the KeypadLinc User’s Manual Toggle Mode
section for more information.
Select and hold the slider control, move it to the level or ramp rate your desire. As you change
these settings the device will proportionately change the lamp brightness or ramp up/down time of
the lamp.
The tree at the right side of the view pane shows the scenes the device belongs to and as a
controller switch showing which devices it controls.
Right mouse clicking on an INSTEON device node, presents a menu as depicted in Figure 36.

Figure 36 – Device Menu

6.3.4.1 Query
Choosing this option causes ISY to query the selected device. The ISY will retrieve the status of
the device and present the status on the view pane. This operation usually takes between 5 to 10
seconds depending on the device.

6.3.4.2 Rename
Choose this option to rename the selected device.

6.3.4.3 Remove
Choosing this menu option completely removes the highlighted device from ISY, deletes all the
associated timer, triggers, and dissociates it from all the scenes it may have belong to.
In case of “Remove from Scene”, choosing the menu option removes the selected device from
the Scene within the context of which it was selected.

6.3.4.4 Replace
This menu option allows you to replace a defective device assigned to a device name with a new
device. The ISY takes care of removing the defective device address from the device name and
adding the new device address into the existing device name. It will swap all the linking
information from the defective devices to the new device.

Figure 37. Compatible device replacement list.

To replace a defective device, you must first add the replacement device
Then right mouse click the device node/name with the defective device. Select Replace menu
and choose the replacement device from the menus of compatible or available devices.

6.3.4.5 Add to Scene
When there are many devices, using the drag and drop method sometimes becomes challenging.
Choose this menu option to drop a device into a scene manually.

6.3.4.6 Restore Device
There might be cases where, for a variety of reasons (such as manual linking), a device does not
perform as represented in ISY. In these cases, choose this option to restore all the links and
reprogram the device to what’s logically represented in ISY.

6.3.4.7 Copy Attributes
This menu option allows you to copy attributes from one device and paste them into another.
Attributes are such things as On Level, Ramp Rate, Set Point, etc.

6.3.4.8 Paste Attributes
This menu option allows you to paste the attributes which were copied into the selected device.

6.3.4.9 Properties
The purpose of this dialog box is to add additional information for each node (device) such as the
location and the description.
The isLoad check box can be used to show whether or not this device is actually controlling or
physically connected to a load.
The information gathered here is included in the HTML file created in Generate Topology Menu

Figure 38. Properties Dialog Box.

6.4 Scene
Scenes are groups with members comprising of INSTEON devices. Each of which may have a
certain pertinent and permissible attributes for that specific Scene. For instance, a SwitchLinc
may become a Controller for a scene and all the other devices assigned to the scene would
respond to it based to On Level and Ramp rate attributes (if applicable) for that scene.
Attributes for all devices are stored in the devices itself. These attributes are invoked in three
levels of your lighting network, the ISY, Controller and Local.

The ISY as the controller of the scene relies on a trigger(s) or schedule(s) defined in the program
detail tab to invoke these attributes. Meaning, if the conditions set in the program is met and the
action defined is the start the scene, the ISY will use the scene attributes at this level to create
the lighting scene. The attribute setting for this scene is found at the scene folder level.
A device controller, Switchlinc or Keypadlinc, relies on the physical actuation of the switch to
invoke the scene attributes. If the controller switch is pressed, the controller will set the lighting
scene based on the scene attributes assigned at this level. The settings can be found at the
device level of the scene. These attributes are completely independent of the ISY scene
attributes.
Local control or noted as “Applied Locally” is when a device within a scene is locally controlling its
own load. This is true for Switchlinc and Kepadlinc’s load key.
When the Scene folder is selected the ”Apply Changes to All Devices” checkbox is available.
See Figure 39. This feature will allow the user to copy the attributes (On level and ramp rate) of
the last device that was set to all devices within the scene. These attributes are stored in each
device and is invoked only by the ISY.
A controller device within the Scene folder is noted in RED italicized text. When selected, the
same sets of sliders in the Scene folder are presented on the screen. The difference is “Copy
from Scene Attributes from …” button is now made available so that you can copy the same ON
level and ramp rates from the Scene folder. Note that these settings are invoked by the controller
and not the ISY. Therefore attributes set in this level is completely independent of the attributes
found in the Scene folder.

Figure 39. Apply changes and Copy Attributes.

A scene can help create the right ambiance for a certain event by a simple click. For example in
Figure 40 we have created a movie scene. The lights in the Living Room were set to be turned
on at the desired light intensity while viewing a movie.

To populate a scene, simply drag and drop INSTEON devices into the scene.

Figure 40 – Scene Node expanded.

Figure 41. Scene menu on a right mouse button click.

In Figure 42 – Living Room-Movie Scene you will find the detail screen of the devices assigned to
the scene. You can control or set all the devices of the scene using this screen. Every time the
scene is triggered the controller will use these settings to set all the responders,

Figure 42 – Living Room-Movie Scene

6.4.1 Query
By selecting any of the scenes you created and clicking on the right mouse button you will be
presented with the Scene Menu as depicted in Figure 41. When you select the Query option on
the menu, the ISY will start to query the network to retrieve the status of each device linked to it.
Any new status retrieved is presented in the table.

6.4.2 Rename
The Rename menu option allows you to rename the selected scene.

6.4.3 Remove Scene
The Remove Scene menu option will completely remove the scene and all its members from ISY.

6.4.4 Creating a Scene
The following steps show how to create a scene.
a. Select New Scene Menu from the Link management menu or tool bar Icon.
b. Name the scene you wish to create and enter this in the Name field of the Scene
dialog.
c. Once you created the scene, this will be added to the Tree View having its own
scene node.

d. Add the devices to the scene. You can select a device or multiple devices then
drag and drop them to the scene. To select multiple devices, select the first
device, hold down CTRL key then select the next device or devices. Once all the
devices are selected, drag and drop this to the scene.
e. You will be presented with a Confirm Add dialog with a list of all the devices you
selected. Assign the controller and responders by highlighting the device and
select controller/responder button. From this dialog you can also remove
devices.

Figure 43. Confirm Add dialog.

f. Select OK.
g. The system will add these devices to the scene. A System Busy dialog will be
with a progress bar will be shown. Depending on the complexity and the number
of other devices, especially with controllers/masters, it may take roughly 10
seconds to a few minutes to program the device(s) in becoming part of a scene.
Heed the note within the dialog box.

Figure 44. System Busy Dialog.
h. Set the scene attributes by adjusting the sliders for each device.

7 Program Summary Tab
This tab shows the program names in a table form showing if it is enabled, the status, the type of
program, the last run time and the last finish time.

Figure 45. Program Summary screen.

The Name column contains the program names created in the Program Detail tab.
The Enable column defines whether the program is ON or OFF. When set to OFF, the program
is stopped from acting on any stimulus that starts the program. When set to ON, it allows the
program to act on the stimulus to start it.
The Activity column represents the program process. The program states are; Idle, Running
‘Then’ and Running ‘Else’. Idle state, is when the program is running and is waiting for the
stimulus to occur. It will also show Running ‘Then’ and Running ‘Else’ messages. These
messages are momentarily shown as the program enters and exits the Then or Else statements
within the program.
The Status column presents you with the program state. You will only be presented a True or
False state in the column.
The Path column shows the program location in the program detail tab. Refer to 8.
Last Run Time and Last Finish Time columns are a time log or time stamp of when the program
started and ended.

7.1 Pull Down Menu and Apply Button
The pull down menu has a selection of Enable, Disable, Run, Run Else, Stop, Run at Boot and
Not Run at Boot. These are actionable commands that are entered in the applicable Enable or
Run at Boot column.
Enable – enables the program to run
Disable – disables the program so that it will not ever run unless enabled
Run – runs the program regardless of the condition
Run Else – runs the Else block of the program
Stop – Stops the program if currently running
Run at Boot – whenever the system is rebooted, this program runs regardless of the condition

Figure 46. Program Summary tab pull down menu.

To enter the command in the enabled column:

a. Select the command in the pull down menu.
b. Select a program row in the table. Move the mouse pointer to the row and press
the left mouse button.
c. Select the Apply button.

7.2 Edit
When a program row is on the table is highlighted and the Edit button is selected, the system will
immediately jump to program detail screen showing you the code of the program selected.
Refer to Figure 47 for a sample of the program detail screen.

7.3 Refresh Button
The refresh button updates the summary table if you feel the table is not up to date.

8 Program Details
This tab gives the user the ability to create timer or trigger programs.

Figure 47. Program Detail screen.

8.1 Program Detail Layout
The GUI is divided into four areas; Tree View, Manage program, Program content, Add to
program and Schedule. Refer to Figure 47.

8.1.1 Tree View
This area shows the tree containing all of your programs and folders. When a new program is
created, it is added to this tree. The tree has three levels; the root (My programs), the program
folder and the programs.
Program folders can have conditions. These conditions must be met before any programs within
the folder will run.
You may rename, move, change or delete your old schedules and triggers anytime you wish. You
may organize your programs in folders using drag and drop.
A right mouse button press on different levels of the tree will show a menu pertinent to the folder
chosen. The figure below shows a sample of menu when place the mouse pointer on ‘My
Programs’ folder and press the right mouse button.

Figure 48. My Program Node Menu.

8.1.1.1 New Folder
Select this option to create a new folder. This option always creates a new folder at the next
lower level of the tree.

8.1.1.2 New Program
This option creates a new program. To create a program in a specific folder, select a folder the
program will be located. Select New Program option from the menu; name the program in the
highlighted field. If you did not rename the field, the program name will be entered as

. The green arrow indicates that the program has not been saved. This arrow
disappears after the Save Changes button is selected.
Selecting a program then the New Program option will create a new program at the same level as
the selected program.

8.1.1.3 Rename
Select this option to rename a folder or program.

8.1.1.4 Copy
Select this option to copy a folder only or a program. The copied folder or program will be added
at the same level of the tree. It will have the same name as the copied folder or program with the
word COPY appended to it. It will be highlighted giving you the opportunity to rename the folder
or program.

8.1.1.5 Copy Tree
This option is only shown at the root level containing folders or folders containing the programs.
When selected a dialog box will ask you to if you want to copy the folder and all its contents.
Select Yes if you want a copy of the folder and its contents. Selecting No will abort the process.

Figure 49. Copy tree dialog.

8.1.1.6 Remove
Select this option if you want to delete a folder or a program.
If you try to delete any programs or folder, you will be prompted with a dialog box to confirm the
deletion.

8.1.1.7 Import
Use this option if you are importing a folder or a program file. It will import all programs in the file
into the selected folder.

8.1.1.8 Export
Use this option if you are exporting a folder or a program file. If you selected a folder for export, it
exports the folder and its contents. If you selected a program, it will only export the program.

8.1.1.9 Copy to Clipboard
This option copies the program as a text format and keeps it in the clipboard for pasting to a text
editing program.

8.1.2 Manage Program
The manage program have four select buttons; New Program, New Folder, Undo Changes and
Save Changes.
New program and New folder buttons function the same as the menu option accessed via a right
mouse button press. Refer to 8.1.1.1and 8.1.1.2.
Selecting Undo Changes button cancels the revisions or edits done to the program. It removes
the changes since the last save. This can undo changes to many programs and folders.
Save changes button stores the revisions or edits done to the program. You cannot undo the
revisions after the Save changes button is selected.

8.1.3 Program Content
This area is where the conditions and action definitions selected in Add to Program is placed.

8.1.4 Add To Program
This area facilitates the user in building the program. It simplifies the program building process
by providing the user a preformatted edit space filled in using Schedule, Condition and Action
buttons. It even provides you with a button to add comments in the program.
IF – has the condition that must be met to for the program to run. This condition is the trigger for
the program to take action.
THEN – is the primary action when the condition is met. The program here stays running as long
as the condition is met or True.
ELSE – is the secondary action when the condition is no longer met or False and only after the
primary action was taken.
Your program is not limited to one condition and action. You can have multiple condition and
actions defined in the program. Multiple conditions are created using the And/Or pull down menu
field. Buttons labeled Add And (…) or Add Or (…) will be available only after a second condition
is added. The use of this button allows adding a parenthesis to your program condition. An
example of a program with multiple condition and action is shown below.

Example Program:

Formatted: Indent: Left: 0.25",
Space Before: 0 pt

If
Control '07.D5.27.1' is not switched Off
And Control '07.D5.27.1' is switched On
And (
On Mon, Tue, Wed, Thu, Fri
From 9:00:00AM
To
5:30:00PM (same day)
Or On Sat
From 10:00:00AM
To
2:30:00PM (same day)
)
Then
Wait 20 seconds (Random)
Repeat Every 0 seconds
Set '04.BE.F7.1' 60%
Wait 20 seconds
Set '04.BE.F7.1' Off
Wait 10 seconds (Random)
Else
Set '04.BE.F7.1' On

Figure 50. New Program Screen.

The enabled check box allows the system to run the program. Unchecking this box disables the
program.

8.1.4.1 Schedule
The schedule button is used to enter time events into the IF section as a condition. When
selected the lower portion of the Add to Programs area changes its selection fields.
A check box for each day of the week and All (for all days) is available. This set the days of the
week the timer event will occur.
There are six pull down menu fields beneath the weekday checkbox. The first 5 fields define the
occurrence and the sixth field defines if the occurrence is based on Time, Sunrise, Sunset or Last
Run. Depending on the selection on the sixth field, the time set field (fields 2 to 5) setting will
change. Refer to Figure 53 and Figure 54.
A schedule can be set to occur at a specific or between the specified times. Selecting Time Is
(refer to Figure 51) is for setting a specific time and From/To (refer to Figure 52) is setting for
between specified times.
The To field can be changed to For, defining the duration of the event based on time the start
time. If you assigned a timer event to start at a time in a specific day of the week, and the For
duration puts the end time to the next day, the ISY will complete the event timer on the next day.
The timer event will always start at the set time of the selected weekday. For example, the start
time (From) was set at 1:00PM on Monday and would last For 23Hrs. In this example the event
will end on Tuesday at 12:00 noon. It will always start on Monday and end on Tuesday. This is a
valid setting.

Figure 51. Schedule Time Is condition fields.

Figure 52. Schedule From/To condition fields.

Longer daylight and shorter night time in summer. Shorter daylight and longer night time in
winter. The change in sunrise and sunset time through out the year from winter to summer meant
that a fixed predetermined turn on or off time of lights meant you may either be turning on or off
the lights too early or too late. Timer event based on Sunrise or Sunset instead of a specific time
should solve this. You have the option to advance or delay the event to occur by setting the time
and before/after fields.

Figure 53. Sunrise/Sunset field set.

The Last Run option is an event timer based on the last runtime of the selected program. Refer
to Figure 54.

Figure 54. Last Run field set.

To add a timer event to a program, select or create a new program. Set the time conditions for
the timer event. Click on ‘Add to IF’ button to place the timer condition in the program.

8.1.4.2 Condition
Unlike the Schedule button that that uses the time as a trigger, the condition button uses the
devices or a program to trigger the action. Conditions that are defined is added to the IF section.
The INSTEON device status and controls are conditions for the trigger. Select ‘Status’ or
‘Control’ in the menu.
Another device is X10 devices. Selecting ‘X10’ from the menu will set the ISY to look for X10
command.
The ‘Program’ option uses the status of another program for a trigger.

Figure 55. Device and Program condition select.

The program state is set to True when the program enters the Then path and False when it
enters the Else path. Folder conditions can be set based on the program state. This state is also
reported in the Status column in the program summary table.
Select ‘Add to IF’ button to add the triggers to the condition section.

8.1.4.3 Action
The action button adds the action information in the ‘Then’ and ‘Else’ section of the program. It is
defines the action taken after the condition is met or the trigger occurs.
An action can be setting a device to a defined state that is ON/OFF or set level. The type of
action is dependent on the device type. The devices that are supported are INSTEON or X10
compatible devices.
Besides setting a device, an action can also be to:
a. Run or Stop a Program.
b. Notify the addresses in the Recipients List.
c. Wait for a specified period or randomly within the specified period.
d. Repeat for a specified period or for a set number of times. Action statements
following the Repeat action are indented. They will be repeated per the specified
period or the set number of times.
The repeat and wait actions have a random option. This is set by selecting the Random check
box. A random value from 1 to the entered value will be randomly chosen each time the action is
run.

Figure 56. Action command set.

8.1.4.4 Comment
Select the comment button to show the comment entry field. This field is a free form field without
character count limit.
Select ‘Update’ button to add the comment in the program.

Figure 57. Comment entry field.

9 Configuration
The Configuration Tab allows the users to manage global settings such as Location/date/time and
notification settings.
This view is divided into two sections:
i.
Location, Date,Time configuration.
ii.
Notifications configuration.

Figure 58. Configuration Tab screen.

9.1 Configuring ISY’s Physical Location
The ISY has the capability to calculate the sunrise or sunset time based on the physical location
set in the device. By using the Sunrise or Sunset time to control the light, this ensures that lights
are efficiently turned on at dusk and/or turn off at dawn.
To set or change the location of the ISY, select the Change Location button. For a relatively
accurate Sunrise/Sunset calculations, select the closest city in which the ISY will be physically
located. If the city you are located in does not appear on the list select the closest city with the
same time zone.

9.2 Date and Time Configuration
You can set or change the time and date in your ISY in two ways.

i.
ii.

Using the Synchronize Clock with Computer’s Time button. Once you selected this option
the ISY will be automatically updated using the computer’s time.
And by selecting Manually Adjust the Clock button. After selecting this button, you will be
presented with Adjust Date and Time screen (refer to Figure 59). You can make the
entry or adjustment in this screen.

To manually adjust the time and date:
a. Click on the Adjust Date/Time button; you will be presented with the Adjust
Date/Time dialog.
b. Choose the Daylight Saving Mode if it applies.
c. Enter the time
d. Choose the day (you can click on the day buttons)
e. Choose the month and year using the left or right buttons. Selecting left or right
buttons (< or >) steps the month. Selecting the double left and right (<< or >>)
steps the year.
f. Click Ok
The ISY date and time will be updated immediately to reflect the new date and time.

Figure 59 – Adjust Date & Time Dialog

9.3 Messaging Configuration
The System Tab has Messaging Providers list. This provides a list of companies which provide
messaging services and the messaging method, that is email or text message.

9.3.1 Email Message
To receive notifications via Email from the ISY, select the Regular Email on the list. This is the
first entry on the Messaging Providers list.
Once Regular Email is selected you will be requested to enter the full email of the recipient at the
entry field located at bottom of the list. Enter the recipient’s email address and select the Add
button. The recipient will be added to the recipients list which is located on the bottom right of the
Messaging Configuration screen. Make sure you select the Save button to store the list.
You may add up to 5 recipients but you must add them one at a time.

9.3.2 Text Messages/Page
To receive a page or a text message from the ISY you must select your pager, cell phone or
blackberry service provider from the list by clicking on their company name. Once you clicked the
provider’s name you will be requested to enter the 10 digit pager or phone number of the
recipient. Enter the recipient’s number at the entry field located at bottom of the list and press the
Add button. The recipient will be added to the recipients list on the right. Make sure you select
the Save button to store the list.
Enter the digits only, that is without any symbols and without the ‘1’ prefix:
Correct number entry: 8186310333
Incorrect number entry: 1-818-631-0333
You may add up to 5 recipients who may have different messaging service providers. Please add
the recipients one at a time.

9.3.3 Recipients
Recipients listed on the recipient list can be removed one at a time by selecting the Remove
button located at the bottom of the Recipients list. To delete the complete list select Remove
All button.
You may also Edit each recipient by selecting their entry from the Recipients list and pressing the
Edit button. Make sure you select Save once you are done editing. Exiting the screen will not
store your changes.

10 Errors and Error Messages
10.1 Red Exclamation Mark
i.

ii.

If you see a red exclamation mark next to a device then you have lost connectivity to that
device. Wait a few second and see if the device comes back on its own. If it does not
then the device might be faulty or something was changed in the environment which
affects the connectivity between the device and the ISY
If you see a red exclamation mark next to the Network node and all the devices listed in
the Tree View, see Figure 60, you have probably lost connectivity to the ISY. You must
re-login, select the Login option under the File Menu. If you are unable to re-login please
reboot the ISY.

Figure 60. Connectivity Lost

iii.

If you are not getting the Linking in Progress Dialog as shown in Figure 8, check you
connection with the PLM or the PLM device itself.

10.2 To Report an Error
To report an error, please send an email with the error description to:
tech@universal-devieces.com
Please provide the error and the situation in which the error presents itself. If possible please
include a screen shot(s).

